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Introduction

Cinelerra is a software program NLE, Non-Linear Editor, that provides a way to
edit, record, and play audio or video media. It can also be used to retouch photos.

This manual covers Cinelerra-GG Infinity version. The author of the original Cinel-
erra, Adam Williams, as well as many different people worked on Cinelerra over the
years. The software and this manual were merged in from various sources and each per-
son is to be thanked and commended for their efforts. Numerous software modifications
were made by William Morrow. These are all under GPLv2+ license. Refer to: https:
//www.gnu.org/licenses/old-licenses/gpl-2.0-standalone.html

This is a copy of the header from the original source code.
/*
* CINELERRA
* Copyright (C) 1997 -2012 Adam Williams <broadcast at earthling dot

net >
*
* This program is free software; you can redistribute it and/or

modify
* it under the terms of the GNU General Public License as published

by
* the Free Software Foundation; either version 2 of the License , or
* (at your option) any later version.
*
* This program is distributed in the hope that it will be useful ,
* but WITHOUT ANY WARRANTY; without even the implied warranty of
* MERCHANTABILITY or FITNESS FOR A PARTICULAR PURPOSE. See the
* GNU General Public License for more details.
*
* You should have received a copy of the GNU General Public License
* along with this program; if not , write to the Free Software
* Foundation , Inc., 59 Temple Place , Suite 330, Boston

This is a copy of the information in the Cinelerra-CV manual.
Copyright c 2003, 2004, 2005, 2006 Adam Williams - Heroine Virtual Ltd. Copy-

right c 2003, 2004, 2005, 2006, 2007 Cinelerra CV Team.
This manual is free; you can redistribute it and/or modify it under the terms of

the GNU General Public License as published by the Free Software Foundation; either
version 2 of the License, or (at your option) any later version.
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This document is distributed in the hope that it will be useful, but WITHOUT ANY
WAR- RANTY; without even the implied warranty of MERCHANTABILITY or FITNESS
FOR A PARTICULAR PURPOSE. See the GNU General Public License for more details.

You should have received a copy of the GNU General Public License along with this
program; if not, write to the Free Software Foundation, Inc., 51 Franklin St, Fifth Floor,
Boston, MA 02110, U

Cinelerra Overview

Presented briefly here is an overview of Cinelerra-GG Infinity and information pro-
vided in this manual. The GG version of Cinelerra has been improved for stability,
modernized to accommodate the current state of Linux software, enhanced with addi-
tional basic features, and enriched with new features imagined by dedicated users and
then implemented by professional programmers.

Website https://www.cinelerra-gg.org
The website for the cinelerra-gg software is a good place to start for informa-
tion, help, and documentation. It is professionally maintained and continuously
updated with more language translations ongoing.

Stability
Software programs that “just work” are a #1 priority in order to be of use for
producing quality videos. A large amount of time has been invested in debugging
problems and resolving crashes. And in a continuous process to do so, a chapter
on Troubleshooting is included in order to easily provide sufficient information
for users to capture issues and crashes so that they can be analyzed and quickly
fixed to avoid repeat problems.

Modernization
Artistic creativity has been applied to modernize the Cinelerra-GG plugin icons for
video and audio to even include the ffmpeg plugins. The Cinfinity set of plugin
icons come in square or roundish versions — your choice. In keeping up with the
current expectation of users for a certain “look and feel”, a very modern Neophyte
theme recent addition provides an alternative to the already existing 9 themes.
These 10 themes give the user the choice to get the look they like best for their
own eyes.

Cerrent and up-to-date
For today’s software, included thirdparty libraries are kept up to date in a timely
manner and effort is made to always used a relatively recent version of FFm-
peg, if not the latest. This is a big deal because there is a whole set of separate
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programmers continuously working diligently to cover all of the old and newly
created formats. Thus Cinelerra programmers can be dedicated to working solely
on Cinelerra rather than just trying to keep up with many formats.

FFmpeg usage integration
By using FFmpegwith Cinelerra there is the advantage that users can directly
convert videos via pre- and post-processing, without the need for command lines
to be executed manually before or afterwards.

Import and Export formats
Listed here are only a few of the supported Import and Export formats:

• several standard native formats, such as mpeg, ac3, flac, exr and jpeg/p-
ng/ppm/tiff sequences

• FFmpeg’s over 400 decoders and 150 encoders accessible from within Cinel-
erra to include: mp4, mkv, mpeg, mov, m2ts, mp3, dvd, ogg, theora, prores,
tiff, webm, flac, opus, vorbis, quicktime (div, dnxhd, jpeg, mjpeg, mp4, rle,
v308, v410), h264 & h265 usage, avc, hevc, and recently released AV1 and
WebP

• raw image format for over 700 supported cameras, courtesy Dave Coffin
DCraw

Standard Features

• Program window for video and audio tracks, navigation, popups, playing
and seeking functions.

• Editing via track manipulation with either drag and drop editing or cut and
paste editing.

• Patchbay tools: fader, gang, arm, enable output, expanders, mixers, and
blending operations.

• Undo and Redo capability for many editing functions.

• Drag handle functionality for Ripple, Roll, Slip, Slide, Edge, and No Effect.

• Dynamic Keyframe support with curve, toggle, automatic, compositor, and
editing capabilities.

• Proxy editing support to speed up editing for large formatted files or slower
computers.

• Compositor window with masking, zooming, cropping, projector and cam-
era capabilities.
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• Viewing window for quickly viewing/playing audio, video, clips, or proxies.

• Resources window with Media, Proxy, Clips, Video and Audio Effects/Tran-
sitions.

• User defined bins/folders for a project.

• Expandable Video/Audio effects for grouping selections such as Color Cor-
rection or Motion plugins.

• Included are over 400 Plugins – audio and video native, FFmpeg, plus ex-
pandable to include others.

• LV2 and Ladspa plugins audio support.

• Mouse over Media or Proxy folders to get a 5 second real time preview of
the media.

• Single or multiple files rendering; background rendering, batch rendering,
command line rendering, and use of a Render Farm to take advantage of
multiple computer CPUs.

• Numerous pre-defined output formats automatically available and allowance
for user-defined formats.

• Capture and Recording capability to include Broadcast TV recording, edit-
ing, and viewing.

• Hundreds of Shortcuts are defined which are easily viewed using the shell
commands pulldown.

• PorterDuff operations are available in the patchbay of the main timeline
window for alpha blending.

• Color correction + 8-bit and 10-bit color space.

• Up to 8K video supported.

• ShuttlePro and ShuttleXpress functionality.

• International language support.

• Multi-screen, Multi-viewers, Multi-session, Multi-pane capability.

• Menu bar shell commandswith reference to somemanuals and user-definable
additions.

• Video stabilization, Motion tracking, Motion Graphics.

• Blade Cut / Hard Edges, Snap/Cut editing and Snap Dragging.

• OpenGL support as well as Direct X11 speedup.

• Advanced Trim Features and Grouping.
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• Asset and Title colors selection including Alpha slider adjustment.

Innovative New Features

• Inter-View mode as invented through a collaborative effort by a user and the
developer.

• Proxy settings for large formatted media with the coveted Scalar option and
proxy quick switch.

• Multiple cameras / Mixer Viewer with the number of cameras only limited
by the resources on the user’s computer (on a large system, 50 are known
to work).

• DVD/bluray creation, editing, and copying for non-commercial media greatly
enhanced for usability.

• Title plugin virtually unlimited script size with many changeable attributes
such as size, blink, color.

• Motion Graphics using the Sketcher plugin to create elements such as el-
lipses, rectangles and shapes for simpler motion graphics.

Chapters Overview

Below is listed a brief overview of each chapter to help you to decide which chapters
you should pay the most attention to and read more thoroughly. And which chapters
are important for beginning to learn to use Cinelerra-GG. At the end of the descriptions
is a list of the sections to read for beginners.

Chapter 1 Installation.

If you just want to get started using the program, you can safely skip this chapter
and instead go to: https://www.cinelerra-gg.org and simply download a
pre-built linux version for your Operating System. If you would like to do your
own builds so that you always have the latest, refer to this chapter to learn how.
But if you are already familiar with doing your own builds, you can just refer to
this chapter if you encounter issues.

Chapter 2 The 4+ Windows.

It is important to understand the window setup in Cinelerra-GG and what each of
them is used for. In addition this chapter covers some basic navigation functions
that you will need to know. However, if you have used an NLE before and don’t
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mind experimenting to learn how to execute certain functions, probably there is
no need to peruse this chapter.

Chapter 4 – Project and Media Attributes.

This chapter is helpful for basic understanding of setting up your session but it
can easily be skipped.

Chapter 5 Load, Save, and the EDL.

Since this is important to not losing your work, you should read this chapter for
some basic usage concepts and for some lesser used functions that may come in
handy. Besides how to Load and Save files, there is also information on using raw
camera formats. Helpful hints on working with image sequences, such as a bunch
of pictures from your camera all loaded at once, is a time saver.

Chapter 6 Editing.

New and occasional users will find it necessary to read this chapter. However,
you can decide which editing mode you prefer and concentrate on reading that
section. Even seasoned users will want to read this chapter in order to take advan-
tage of features that have been newly implemented or may be less familiar due
to infrequent usage. Anyone who wants the editing capabilities that comes with
use of the Shuttle Jog Wheel, will initially need to read that section to become
familiar with its usage.

Chapter 7 Rendering.

Minimally most users will need to read the section on single file rendering to get
started; since after all the whole purpose of using an NLE is to create your own
media. The end of this chapter includes some helpful specific rendering scenarios
which could prove quite useful. You might also want to consider using batch
rendering and background rendering for performance reasons. And, of course,
render farm usage to take advantage of multiple computers can be a real boost.

Chapter 8 Keyframes.

This is a more advanced topic but extremely useful to know. Keyframes are data
values that have been associated to the timeline that affect the media presenta-
tion. You can go for years without knowing all of the nuances but you will most
likely have a need to use and understand them sooner or later.

Chapter 9 Ffmpeg Interactions.
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Skip this chapter if you are just getting started. Skip this chapter if you just want
to use common formats that are already set up for you. Experts may want to refer
to this chapter in order to set up their own option files.

Chapter 10 Effect Plugins.

Use this chapter as a reference to add an audio or video plugin in order to correct
color or add some fancy effect. You will not want to read about each and every
plugin, most of which you will never use. On the other hand, going over the
section on “some specific details concerning plugins” might come in handy.

Chapter 11 Transition Plugins.

Everyone who does not know about using transitions should read this chapter
because you will want to use transitions between cuts in your video for smoothly
changing scenes. It is short and easy reading.

Chapter 12 Overlay Modes, Alpha Blending, and Porter Duff.

Experts can really use the information in this chapter to spiff up their editing work
through some blending type techniques. A lot of information and possibilities are
described here.

Chapter 13 Capturing and Recording Media + DVD/Bluray Creation.

If this is what you want to do, then read this chapter. In the case of DVD media
creation it includes many examples and lots of tips for checking your methods. A
section on using cinelerra with broadcast TV is especially useful if that is some-
thing you want to do.

Chapter 14 The 5 Multi-s.

For using multiple cameras in your video creation, this chapter is a must to read.
Otherwise, just refer to the section that becomes pertinent as you familiarize your-
self with using Cinelerra.

Chapter 15 Shortcuts with Keyboard and the Mouse.

Everyone will want to use this chapter to speed up their editing sessions. Once
you find yourself doing the same thing over and over again, you will want to know
if there is a shortcut. Then look here!

Chapter 16 Configuration, Settings, and Preferences

Refer to this chapter when you want to change some setting or preference. Oth-
erwise if a new user, you should make sure to read the first page which includes
some important basic information.
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Chapter 17 How Some Stuff Works.

Only read this chapter if you are confused about a specific covered topic and how
it works.

Chapter 18 Troubleshooting.

Use this chapter for diagnosing a problem and find out what to report to get the
best resolution or help.

Chapter 19 Performance Tips and Other Tips.

There are a few performance tips in this chapter that may eventually prove useful.

Chapter 20 Language Translations.

If you want to help by providing translations for a specific language, there is a
complete description of how to do this and what to do.

Chapter 21 Licenses.

Appendix A QuickStarts

Here you go! If you hate to read, just go over the quick start guide or the youtube
video creation and simply be on your way.

Appendix B Developer’s Section.

Some extra information that developers may or may not find useful.

Appendix C Auxiliary Programs

This is a catch-all for any useful programs that may need to be included, mostly
for analysis.

In summary, “must” reads for a new user would be these chapters or sections:

• Chapter 2 - The 4+ Windows

• Chapter 5 - Load, Save, and the EDL

• Chapter 6 - Editing; read all sections except emphasize only either Cut&Paste or
Drag&Drop

• editing to suit your purpose and then skim the editing mode that is not your pref-
erence as some operations work in either mode. Skip the Shuttle section unless
you have this jog wheel in hand.

• Chapter 7 – Rendering; minimally read the “single file rendering” section.
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• Chapter 10 – Effect Plugins; read the section on “how to use plugins”.

• Chapter 11 – Transition Plugins

• Chapter 16 – Configuration, Settings and Preferences; read at least the first couple
of paragraphs.
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Chapter1
Installation

1.1 How to Build Cinelerra-GG from Developer’s Git
Repository

These are generic build instructions for building Cinelerra-GG Infinity. Known to
work on ubuntu, mint, suse/leap, fedora, debian, centos, arch, and slackware. It has
not been tested on every single possible distro yet so you might expect to have to make
some minor changes. Patches have been created to build on FreeBSD through the work
of another programmer and a Gentoo version is being maintained elsewhere by another
programmer.

Alternatively, there are some pre-built dynamic or static binaries which are updated
on a fairly regular basis (as long as code changes have been made) available at the link
below.

https://cinelerra-gg.org/download/
There are 2 kinds of builds, the default system-build and a single-user build. A

system build has results which are installed to the system. The majority of the files are
installed in the standard system paths, but some customization is possible. The single
user build allows for running completely out of a local user directory so it doesn’t affect
the system.

We recommend the single-user version when possible. It makes it very easy to
install a new version without having to delete the older version in case you want it for
backup – once you are happy with the new version, all you have to do is delete the entire
old directory path. Also, if you install a new Operating System version and if you have
Cinelerra on separate disk space that is preserved, you won’t have to reinstall Cinelerra.
In addition for purposes of having the ability to interrupt or to see any possible error
messages, if you start the application from a terminal window command line you will
have more control to catch problems. However, the system builds can be useful in a
university lab setting where there are possibly multiple users, or multiple versions.

There are two notable differences between “standard” views of Cinelerra and this
implementation for the system builds. Both of these can be configured during instal-
lation. These differences make it possible to have several different versions installed
without having them “walk” on each other.

1
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1. Installation

1. application name can be set during installation and defaults to: “cin”

2. the home configuration directory can also be set and defaults to:
“$HOME/.bcast5”

To do a system build, you should read the README that is at the top level after you
get the source.

1. You need at least 2.5GB of disk storage to operate a build + you need to have
“git” installed.

2. Obviously in order to install into the system, you must run as root.

3. The "git" step has to download many files (approx 100MB) so allow time.

4. Run the following commands (this takes awhile):

1 $ cd /<build_path >/ # this is where you need the 2.5GB of
disk space

2 $ git clone --depth 1 "git://git.cinelerra -gg.org/goodguy/
cinelerra.git" cinelerra5

3 $ cd cinelerra5/cinelerra -5.1 # toplevel directory

NOTE: if your system has never had Cinelerra-GG Infinity installed, you will have
to make sure you have all of the compilers and libraries necessary. So on the very
first build you should run:

1 $ ./blds/bld_prepare.sh <os> # where <os> represents the Operating
System of centos, fedora, suse, leap, ubuntu, debian.

2 $ ./ autogen.sh
3 $ ./ configure --prefix =/usr # optional parameters can be added here
4 $ make 2>&1 | tee log # make and log the build

5. Check for obvious build errors:
1 $ grep "\*\*\*.* error" -ai log

If this reports errors and you need assistance or you think improvements can
be made to the build s, email the log which is listed below to cin@lists.
cinelerra-gg.org:

1 $ /<build_path >/ cinelerra5/cinelerra -5.1/ log

2

cin@lists.cinelerra-gg.org:
cin@lists.cinelerra-gg.org:


1.1. How to Build Cinelerra-GG from Developer’s Git Repository

6. If there are no build errors, finally just run:
1 $ make install

7. If it all worked, you are all setup. Just click on the cinelerra desktop icon.

To do a single-user build, read the README that is at the top level after you get the
source.

1. You need at least 2.5GB of disk storage to operate a build + you need to have
“git” installed.

2. Recommend you build and run as root, just to avoid permission issues initially.

3. The "git" step has to download many files (approx 100MB) so allow time.

4. Run the following commands (this takes awhile):
1 $ cd /<build_path >/ # this is where you need the 2.5GB of

disk space
2 $ git clone --depth 1 "git://git.cinelerra -gg.org/goodguy/

cinelerra.git" cinelerra5
3 $ cd cinelerra5/cinelerra -5.1 # toplevel directory

NOTE: if your system has never had Cinelerra-GG Infinity installed, you will have
to make sure all the compilers and libraries necessary are installed. So on the very first
build you should run as root:

1 $ ./blds/bld_prepare.sh <os> # where <os> represents the Operating
System of centos, fedora, suse, leap, ubuntu, debian.

2 $ ./ autogen.sh
3 $ ./ configure --with -single -user # the “with-single-user” parameter makes

it so
4 $ make 2>&1 | tee log # make and log build (check for errors

before proceeding)
5 $ make install

Then just start the application by keying in: ./cin in the bin subdirectory OR add
a desktop icon by using the appropriate directory to copy the files to, run as root, and
edit to correct the directory path.

1 $ cd /cinelerra_directory_path
2 $ cp -a image/cin.{svg ,xpm} /usr/share/pixmaps /.
3 $ cp -a image/cin.desktop /usr/share/applications/cin.desktop

3



1. Installation

Change the “Exec=cin” line to be “Exec=<your_directory_path>/bin/cin”
The preceding directions for doing a single-user build has been meticulously fol-

lowed to build and run on a newly installed ubuntu 15 system WITHOUT BEING ROOT
except for the bld_prepare.sh and creating the desktop icon.

1.1.1 Notable Options and Caveats

These procedures and the Cinelerra-GG Infinity software have all been run as
“root” on various home laptops and desktops. This provides the best chance to ensure
all works correctly and also allows for handling errors, other problems and potential
crashes with the most success. Included in this section are some of the build variations
easily available for normal builds.

To see the full list of features use:

1 $ ./ configure –help

The default build is a system build which uses:

1 $ ./ configure –without -single -user

In the single-user build, the target directory is always “cin”. Because this is also
the developer build, constant names are used throughout. However, you can rename
files after the install is complete.

f your distro/operating system has issues with the default install to /usr/local,
you might have to change the location to /usr for a system build. Then you will have to
use:

1 $ ./ configure --prefix =/usr

If you wish to change the default directory for a system build you will have to add
the destination directory path on the “make install” line. For example:

1 $ make install DESTDIR=<your selected target directory path >

The application name can be set during installation, but defaults to cin so that the
GG/Infinity build can coexist with other Cinelerra builds if necessary. To override the
default cin name, use:

1 $ ./ configure --with -exec -name=cinelerra

The home configuration directory can also be set, but defaults to $$HOME/.bcast5.
For example:

4



1.1. How to Build Cinelerra-GG from Developer’s Git Repository

1 $ ./ configure –with -config -dir=/ myusername /. bcast5

NOTE: when you specify parameters to the configure program, it will create amake
file as a consequence. Since in a make file, the $ is a special character, it must be escaped
so in order to represent a $ as part of an input parameter, it has to be stuttered. That
is, you will need $$ (2 dollar signs) to represent a single dollar sign.

It may be necessary on some distros which have missing or incomplete up-to-date
libraries, to build cinelerra without Ladspa. To do so, use:

1 $ ./ configure --prefix =/usr --without -ladspa -build

Note that the with-ladspa-dir is the ladspa search path, and exists even if the ladspa
build is not selected. This gives you the ability to specify an alternate ladspa system path
by utilizing the LADSPA_PATH environment variable (that is, the default ladspa build
is deselected).

Note for 32-bit 14.2 Slackware, Debian, Gentoo, Arch, FreeBSD, before running
the configure, you will need to set up the following:

1 $ export ac_cv_header_xmmintrin_h=no
2 $ export FFMPEG_EXTRA_CFG=" --disable -vdpau"

1.1.2 Notes about Building from Git in your Customized
Environment

Getting a build to work in a custom environment is not easy. If you have already
installed libraries which are normally in the thirdparty build, getting them to be rec-
ognized means you have to install the "devel" version so the header files which match
the library interfaces exist. Below is the list of thirdparty builds, but this list may have
changed over time:

The "yes" means force build and “auto” means probe and use the system version
if the build operation is not static. To get your customized build to work, you need
to change the probe options for the conflicting libraries from "yes" to "auto", or even
rework the configure.ac script. There may be several libraries which need special
treatment.

An example of a problem you might encounter with your customized installation is
with “a52dec” which has probes (CHECK_LIB/CHECK_HEADER) in configure.ac,
but djbfft does not. In this case, djbfft is only built because a52dec is built, so
if your system has a52dec, set a52dec to auto and see if that problem is solved by
retrying the build with:

5
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Table 1.1: List of thirdparty builds

a52dec yes
djbfft yes
fdk auto
ffmpeg yes
fftw auto
flac auto
giflib yes
ilmbase auto
lame auto
libavc1394 auto
libraw1394 auto
libiec61883 auto
libdv auto
libjpeg auto
openjpeg auto
libogg auto
libsndfile auto
libtheora auto
libuuid yes
libvorbis auto
mjpegtools yes
openexr auto
tiff auto
twolame auto
x264 auto
x265 auto
libvpx auto
libwebp auto
libaom auto

1 $ ./ confgure --with -single -user –enable -a52dec=auto .

With persistence, you can get results, but it may take several tries to stabilize the
build. If you need help, email the "log" and "config.log", which is usually sufficient
to determine why a build failed.

If you have already installed the libfdk_aac development package on your com-
puter because you prefer this version over the default aac, you will have to do the fol-
lowing to get this alternative operational.

1 $ export FFMPEG_EXTRA_CFG=" --enable -libfdk -aac --enable -nonfree"

6
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2 $ export EXTRA_LIBS=" -lfdk -aac"
3 $ for f in ‘grep -lw aac cinelerra -5.1/ ffmpeg/audio /*‘; do
4 $ sed -e ’s/\<aac\>/ libfdk_aac/’ -i $f
5 $ done

1.1.3 Cloning the Repository for Faster Updates

If you want to avoid downloading the software every time an update is available
you need to create a local "repository" or repo. The repo is a directory where you first do
a “git clone”. For the initial git clone, setup a local area for the repository storage,
referred to as <repo_path>. The “git clone” creates a repo named "cin5" in the
/<repo_path>/ directory. This accesses over 300MB of repo data, so the device has
to have at least that available. The repo path is always a perfect clone of the main repo.

Setting up the initial clone add “ - - depth 1” before cin5 which is faster/smaller,
but has no history.

1 $ cd /<repo\_path >/
2 $ git clone "git:// git.cinelerra -gg.org/goodguy/cinelerra" cin5
3

4 Cloning into "cin5 "...
5 remote: Counting objects: 20032, done.
6 remote: Compressing objects: 100% (11647/11647) , done.
7 remote: Total 20032 (delta 11333) , reused 16632 (delta 8189)
8 Receiving objects: 100% (20032/20032) , 395.29 MiB | 3.26 MiB/s, done

.
9 Resolving deltas: 100% (11333/11333) , done.

10 Checking connectivity ... done.

Update an existing repo
1 $ cd /<repo home >/cin5
2 $ git pull

Useful git commands
1 $ git clone "git:// git.cinelerra -gg.org/goodguy/cinelerra.git" cin5
2 $ git pull # pull remote changes to the local version
3 $ git status # shows changed files
4 $ git clean -i # interactive clean, use answer 1 to "clean"

7
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1.1.4 How to Build from a Previous GIT Version

1 $ cd /<path >/ cin5_repo
2 $ git log
3 $ git checkout <version >

The “git log” command produces a log file with hash values for commit keys. The
hash ids are the commit names to use when you use git checkout. Next is displayed
sample output:

1 delete stray line in last checkin
2

3 commit 4a90ef3ae46465c0634f81916b79e279e4bd9961
4 Author: Good Guy <good1.2 guy@gmail.com >
5 Date: Thu Feb 22 14:56:45 2018 -0700
6

7 nested clips , big rework and cleanup , sams new icons , leaks and
tweaks

8

9 commit f87479bd556ea7db4afdd02297fc00977412b873
10 Author: Good Guy <good1.2 guy@gmail.com >
11 Date: Sat Feb 17 18:09:22 2018 -0700

For the “git checkout <version>, you would then keyin the line below for the
following results:

1 $ git checkout f87479bd556ea7db4afdd02297fc00977412b873
2

3 Note: checking out ’f87479bd556ea7db4afdd02297fc00977412b873 ’.
4

5 You are in ’detached HEAD ’ state. You can look around , make
experimental

6 changes and commit them , and you can discard any commits you make
in this

7 state without impacting any branches by performing another
checkout.

8

9 If you want to create a new branch to retain commits you create ,
you may

10 do so (now or later) by using -b with the checkout command again.
Example:

11

12 git checkout -b <new -branch -name >
13

14 HEAD is now at f87479bd ... more file size icon updates , and more
to followend
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1.1. How to Build Cinelerra-GG from Developer’s Git Repository

Later to get the repo back to current, use:
1 $ git checkout master

1.1.5 Debuggable Single User Build

To build from sourcewith full debugging symbols, first build a full static (non_debug)
build as follows but instead /tmp substituted with a permanent disk path if you want to
keep it.

1 $ git clone ...
2 $ cp -a /path/cinelerra -5.1 /tmp/.
3 $ cd /tmp/cinelerra -5.1
4 $ ./bld.sh

Then, to run as a developer in the debugger:

1 $ CFLAGS”=-O2 -”ggdb make -j8 rebuild_all
2 $ cd cinelerra
3 $ gdb ./ci

1.1.6 Unbundled Builds

There are some generic build scripts included in the Cinelerra-GGGIT repository for
users who want to do unbundled builds with ffmpeg already available on their system.
This has been tested on Arch, Ubuntu 18, FreeBSD, and Leap 15 (rpm) at the time this
was documented. The names of the build scripts are: arch.bld , bsd.bld , deb.bld , and
rpm.bld . These scripts are in the “blds” subdirectory. The bsd.bld should be used with
the bsd.patch file in that same directory.

The reason that Cin Infinity traditionally uses thirdparty builds (bundled builds) is
because there are a lot of different distros with varying levels of ffmpeg and other needed
thirdparty libraries. However, some users prefer using their current system baseline
without another/different copy of ffmpeg. With different levels of the user’s libraries,
uncertainty, potential instability, and unknown issues may come upwhile running Cinel-
erra and this will make it, for all practical purposes, impossible to diagnose and debug
problems or crashes. There may be no help in these cases. You are encouraged to re-
port any errors which potentially originate from Cin Infinity, but if the data indicates
alternate library sources, please report the problems to the appropriate maintainers.

With the unbundled builds, some features may not be available and no attempt to
comment them out has been made. So if you use a pulldown, or pick a render option, or
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1. Installation

choose something that is not available, it just will not work. For example, unless special
options were set up by you, the LV2 audio plugins will not be available. Nor will the
codec libzmpeg, the file codec ac3, or DVD creation. The old school file classes will all
work, but some of the formats that come with ffmpeg may not because of the way that
ffmpeg was installed on your operating system. That is because the Cinelerra ffmpeg
is a known static build and is usually the latest stable/released version. In the current
case of Leap 15, libx264 and libx265 are not built in and this can be debilitating; You
can always run “ffmpeg -formats” and “ffmpeg -codecs” to see what is available on your
system.

1.2 Download Already Built Cinelerra-GG

If you prefer to not have to take the time to build Cinelerra-GG Infinity yourself,
there are pre-built dynamic or static binaries for various versions of ubuntu, mint, suse,
fedora, debian, centos, arch, and slackware linux as well as Gentoo and FreeBSD. There
are also 32-bit i686 ubuntu, debian, and slackware versions available. These are up-
dated on a fairly regular basis as long as significant code changes have been made.
They are in subdirectories of:

https://cinelerra-gg.org/download/tars
https://cinelerra-gg.org/download/pkgs
The “tars” directory contains single-user static builds for different distros. This is

the recommended usage of Cinelerra-GG because all of the files will exist in a single
directory. To install the single user builds, download the designated tarball from the
./tars subdirectory and unpack as indicated below:

1 $ cd /path
2 $ mkdir cin
3 $ cd cin
4 $ tar -xJf /src/path/cinelerra -5.1 -*. txz # for the *, substitute your

distro tarball name

Do NOT download the LEAP 10-bit version unless you use h265 (it can’t render
8-bit h265).

The “pkgs” directory contains the standard packaged application for various dis-
tros. This will install a dynamic system version for users who prefer to have the binaries
in the system area and for multi-user systems. In addition, performing the package
install checks the md5sum in the file md5sum.txt to ensure the channel correctly trans-
mits the package. There is a README.pkgs file in the “pkgs” directory with instructions
so you can “cut and paste” and avoid typos; it is also shown next.
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1.2. Download Already Built Cinelerra-GG

1 Depending on the distro , use the instructions below and select the
appropriate

2 setup operations to install , update or remove cinelerr -gg infinity.
(03/04/2019)

3 To upgrade , refresh repo , then replace "install" with "update", or
whatever.

4

5 Email problems to cin@lists.cinelerra -gg.org
6 If repository problems , usually you can manually do an install by

using:
7 wget https :// cinelerra -gg.org/download/pkgs/{ substitute_name }/

cin_5.1.<sub_name >.deb
8 and install it manually , for example: dpkg -i cin_5 .1.{

substitute_filename }.deb
9

10 # GENTOO – courtesy Dominque Michel
11 # There is an ebuild package at this time as of 01/03/2019 at:
12 # https :// svnweb.tuxfamily.org/listing.php?repname=proaudio %2

Fproaudio&path=
13 # %2 Ftrunk %2 Foverlays %2 Fproaudio %2Fmedia -video%2 Fcinelerra %2F&#

ab000caf7024d83112f42a7e8285f2f29
14

15 # FREEBSD – courtesy Yuri
16 # There is a port available at: https ://www.freshports.org/

multimedia/cinelerra -gg/
17 # To use this port: cd /usr/ports/multimedia/cinelerra -gg && make

install clean
18 # and then install this precompiled package via: pkg install

cinelerra -gg
19

20 # FEDORA
21 # Replace the XX in fedoraXX in the next line with your current O/S

version number
22 dnf install cinelerra --nogpgcheck --repofrompath cingg ,https ://

cinelerra -gg.org/download/pkgs/fedoraXX/
23 ##dnf erase cinelerra
24

25 # CENTOS
26 # Python 2 has been updated for other distros to Python 3 so you

might have to create a soft link
27 # to get the correct version. For help , send email to cin@lists.

cinelerra -gg.org
28 # first create the file /etc/yum.repos.d/cin_gg , with the following

contents:
29 [cin_gg]
30 name=cingg
31 baseurl=https :// cinelerra -gg.org/download/pkgs/centos7
32 gpgcheck =0
33 # end of cin_gg
34 yum install cinelerra
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35 ##yum erase cinelerra
36

37 # UBUNTU , replace ub14 with your distro id: ub16 ,ub17 ,ub18
38 # Some ubuntu apt downloads register status as working 0%

constantly while running the package
39 # download , like ubuntu 14. It may take a few minutes for this

step so be patient.
40 apt install software -properties -common apt -transport -https
41 apt -add -repository https :// cinelerra -gg.org/download/pkgs/ub14
42 # UBUNTU 16/17/18 note - This has been known to work , but things

change quickly:
43 # VIP - for the first install , the above line adds cinelerra to /etc

/apt/sources.list but...
44 # Version 16/17/18 of Ubuntu are more strict for licensing so you

will have to edit
45 # the file /etc/apt/sources.list to add [trusted=yes] after deb and

before https ...cin...
46 # For example the line should be: deb [trusted=yes] https ://

cinelerra -gg.org/download/pkgs/ub16 xenial main
47 # Or for ub17: deb [trusted=yes] https :// cinelerra -gg.org/download

/pkgs/ub17 zesty main
48 # Or for ub18: deb [trusted=yes] https :// cinelerra -gg.org/download

/pkgs/ub18 bionic main
49 # Also , on the install you will get an error message that you can

either ignore as cinelerra
50 # will run anyway , or else (the first time only) on the commnand

line keyin:
51 # echo > /etc/sysctl.d/50-cin.conf "kernel.shmmax =0 x7fffffff"
52 apt update
53 apt install cin
54 #to update a previous install (ignore any i386 errors as only 64 bit

version available):
55 apt update
56 apt upgrade cin
57 ##apt remove cin
58

59 # MINT should use the same procedure as Ubuntu , but:
60 # Note: apt -add -repository did not work for me, I had to use the gui

version:
61 # System_OR_Administration ->Software Sources ->Additional

Repositories ->Add a new repository
62 # For Mint18 ,add: deb [trusted=yes] https :// cinelerra -gg.org/

download/pkgs/mint18 xenial main
63 # For Mint19 ,add: deb [trusted=yes] https :// cinelerra -gg.org/

download/pkgs/mint19 bionic main
64 apt update
65 apt install cin
66 #to update a previous install
67 apt update
68 apt upgrade cin
69 ##apt remove cin
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70

71 # DEBIAN uses the same basic procedure as Ubuntu.
72 # The apt -add -repository varies per system so you will have to use

your best judgement
73 apt install software -properties -common apt -transport -https
74 apt -add -repository https :// cinelerra -gg.org/download/pkgs/debian8
75 OR apt -add -repository https :// cinelerra -gg.org/download/pkgs/debian9
76 # VIP - for the first install , the above line adds cinelerra to /etc

/apt/sources.list but...
77 # Debian stretch and jessie are more strict for licensing so you

will have to edit
78 # the file /etc/apt/sources.list to add [trusted=yes] after deb and

before https ...cin...
79 # For example for debian8: deb [trusted=yes] https :// cinelerra -gg.

org/download/pkgs/debian8 jessie main
80 # For example for debian9: deb [trusted=yes] https :// cinelerra -gg.

org/download/pkgs/debian9 stretch main
81 apt update
82 apt install cin
83 #to update a previous install
84 apt update
85 apt upgrade cin
86 ##apt remove cin
87

88 # SUSE/LEAP
89 # (Note: you may have to zypper libavc and libiec versions if not

already installed)
90 # cinelerra packages are unsigned so you will have to ignore:

Package is not signed!
91 # openSUSE LEAP 15
92 zypper ar -f https :// cinelerra -gg.org/download/pkgs/leap15/ cingg
93 zypper install -r cingg cinelerra # or cinelerra10bit for 10 bit
94 # openSUSE LEAP 42
95 zypper ar -f https :// cinelerra -gg.org/download/pkgs/leap42/ cingg
96 # as of 42.3 SUSE there is a new requirement , so you will need to

add:
97 zypper mr -G cingg
98 zypper install -r cingg cinelerra # or cinelerra10bit for 10 bit
99 ## zypper remove cinelerra # or cinelerra10bit for 10 bit

100 #to update a previous install (assuming you enabled autorefresh as
above)

101 zypper refresh cingg
102 zypper up cinelerra # or cinelerra10bit for 10 bit
103

104 # SLACKWARE , substitute slk32 for slk64 and i486 -1 for x86_64 -1
105 wget -P /tmp https :// cinelerra -gg.org/download/pkgs/slk64/cin -{date

}-slk64 -x86_64.txz
106 installpkg /tmp/cin... # name you used in the above line
107 #to update a previous install
108 upgradepkg /tmp/cin... # name you used in the above line
109 ## removepkg cin
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110

111 # ARCH linux
112 # first edit the file /etc/pacman.conf , to include the following:
113 [cingg]
114 SigLevel = Optional TrustAll
115 Server = https :// cinelerra -gg.org/download/pkgs/arch
116 # end of cingg
117 pacman -Sy
118 pacman -S cin
119 ## pacman -R cin

1.3 Distribution Systems with Cinelerra Included

There are also some special complete distribution systems available that include
Cinelerra-GG for audio and video production capabilities.

AV Linux is a downloadable/installable shared snapshot ISO image based on De-
bian. It provides the user an easy method to get an Audio and Video production work-
station without the hassle of trying to find and install all of the usual components them-
selves. Of course, it includes Cinelerra-GG! It is at:

http://www.bandshed.net/avlinux/
Bodhi Linux is a free and open source distribution that comes with a curated list of

open source software for digital artists who work with audio, video, includes Cinelerra
GG, games, graphics, animations, physical computing, etc. It is at:

https://gitlab.com/giuseppetorre/bodhilinuxmedia

1.4 Cinx and a “Bit” of Confusion

Cinx is the exact same program as Cin. The X (x) represents the roman numeral 10
for 10-bit as opposed to 8-bit standard. The third-party library used for x265 must be
specially compiled with –bit-depth=10 in order to produce 10-bit rendered output.
This build will not be able to output 8-bit depth which means you have to retain the Cin
version also. Whatever build ffmpeg is linked to will determine what bit depth it can
output. This is why there have to be separate builds. If you install both packages, Cin
and CinX, you may get “file conflicts of same file name” — just continue.

Keep in mind that the regular 8-bit version works on 8-bit bytes — the standard
word size for computers, but the 10-bit version has to use 2 words to contain all 10 bits
so you can expect rendering to be as much as twice as slow. There is also a 12-bit version
for consideration but currently the results are simply the same as 10-bit with padding
to make 12-bit so it is of no value.
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Chapter2
The 4+ Windows

2.1 Program Window

The main window is called the Program window and contains the timeline as well
as the entry point for all menu driven operations. It is often just called the “timeline”.
The timeline consists of a vertical stack of tracks with a horizontal representation of
time. This defines the output of rendering operations and what is saved when you save
files. To the left of the timeline is the patchbay which contains options affecting each
track. The patchbay is described in detail in the Editing section.

TheWindow pulldown on this main window contains options that affect the 4 main
windows. Default positions repositions all the windows to a 4 screen editing configu-
ration. On dual headed displays, the Default positions operation fills only one monitor
with windows.

2.1.1 Video and Audio Tracks and Navigation

The program window (figure 2.1) contains many features for navigation and dis-
plays the timeline as it is structured in memory: tracks stacked vertically and extending
across time horizontally. The horizontal scroll bar allows you to scan across time. The
vertical scroll bar allows you to scan across tracks.

Video tracks represent the duration of your videos and clips, just as if you placed
real photographic film stock end-to-end on a table. The individual images you see on
the track are samples of what is located at that particular instant on the timeline.

Audio tracks represent your sound media as an audio waveform. Following the film
analogy, it would be as if you "viewed" magnetic tape horizontally on your table. You can
adjust the horizontal and vertical magnification of the tracks and the magnification of
the audio "waveform" display using the zoom panel controls. Every track on the timeline
has a set of attributes on the left, called the patch-bay. It is used to control some of the
behavior of the tracks.

Track Navigation involves both selecting a specific audio or video track and moving
to a certain time in the track. The vertical scroll bar allows you to scan across tracks.
For vertical scrolling you can also use the mouse wheel. The horizontal scroll bar allows
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Figure 2.1: Patchbay | Timeline with pulldowns & navigation icons, Video/Audio tracks
& bottom Zoom

you to scan across time. For horizontal scrolling you can use the mouse wheel with the
Ctrl key.

In addition to the graphical tools, you can use the keyboard to navigate. There is a
shortcuts document for keyboard navigation; it includes, for example, shortcuts like use
the Home and End keys to instantly go to the beginning or end of the timeline. Or in
the default cut and paste mode, hold down Shift while pressing Home or End in order
to select the region of the timeline between the insertion point and the key pressed.

2.1.2 Zoom Panel

Below the timeline, you will find the zoom panel. The zoom panel contains values
for sample zoom (duration visible on the timeline), amplitude (audio waveform scale),
track zoom (height of tracks in the timeline), and curve zoom (automation range). In
addition to the scrollbars, these zooms are the main tools for positioning the timeline.
Also on the zoom panel is selection change and alpha slider.

Figure 2.2: Zoom panel on the bottom of the main program window

Changing the sample zoom causes the unit of time displayed in the timeline to
change size. It allows you to view your media all the way from individual frames to the
entire length of your project. The higher the setting, the more frames you can see per
screen. The sample zoom value is not an absolute reference for the unit of time since it
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refers to the duration visible on the timeline and thus changes also as you modify the
length of the program window horizontally. Use the Up and Down arrows to change the
sample zoom by a power of two. Or if your mouse has a wheel, mouse over the tumblers
and use the wheel to zoom in and out.

The amplitude only affects audio which determines how large the waveform ap-
pears. Ctrl-up and Ctrl-down cause the amplitude zoom to change.

The track zoom affects all tracks. It determines the height of each track. If you
change the track zoom, the amplitude zoom compensates so that the audio waveforms
look proportional. Ctrl-pgup and Ctrl-pgdown cause the track zoom to change.

The curve zoom affects the curves in all the tracks of the same type. It determines
the value range for curves. First select the automation type (audio fade, video fade,
zoom, X,Y) then use the left tumblers for the minimum value and the right tumblers for
the maximum value or manually enter the values in the text box. Normally you will use
-40.0 to 6.0 for audio fade and 0.0 to 100.0 for video fade. The tumblers change curve
amplitude, but the only way to curve offset is to use the fit curves button.

The selection start time, selection length, and selection end time display the current
selected timeline values. The alpha slider allows for varying the alpha value when using
colors on the tracks as set in your appearance preferences for Autocolor assets. It has
no function without that flag set.

2.1.3 Track Popup Menu

Each Track has a popup menu. To activate the track popup menu, Right mouse
click on the track. The popup menu affects the track whether the track is armed on the
patchbay or not. The Track Menu contains a number of options:

Attach Effect opens a dialog box of effects applicable to the type of track of audio or
video.

Move up moves the selected track one step up in the stack.

Move down moves the selected track one step down in the stack.

Delete track removes the track from the timeline.

Add Track adds a track of the same media type, audio or video, as the one selected
above that track.

Find in Resources that media file will be highlighted in the media folder in the Re-
sources window.
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Show edit will point out the exact start and stop points along with the length of the
current edit on that track as well as the media name.

User title is used to change the title name. This is really handy for files that have very
long and similar names that would get cut off during edits. You can use short
names to better differentiate the media. If you select multiple, all those clips will
have title name changed.

Bar color allows the user to select a specific color for the title bar. This helps ease of
locating.

Resize Track resizes the track.

Match Output Size resizes the track to match the current output size.

2.1.4 Insertion Point

The insertion point (figure 2.25) is the flashing hairline mark that vertically spans
the timeline in the program window. Analogous to the cursor on your word processor,
the insertion point marks the place on the timeline where the next activity will begin.
It is the point where a paste operation takes place. When rendering, it defines the
beginning of the region of the timeline to be rendered. It is also the starting point of all
playback operations.

Normally, the insertion point is moved by clicking inside the main timebar. Any
region of the timebar not obscured by labels and in or out points is a hotspot for reposi-
tioning the insertion point. In cut and paste editing mode only, the insertion point can
be moved also by clicking in the timeline itself. When moving the insertion point the
position is either aligned to frames or aligned to samples. When editing video, you will
want to align to frames. When editing audio you will want to align to samples. Select
your preference by using Settings→Align cursor on frames.

2.1.5 Editing Modes

There are 2 different editing methods of operation that affect the insertion point
and the editing on the timeline. There is: drag and drop mode and cut and paste mode.
The editing mode is determined by selecting the arrow or the I-beam in the Transport
and Buttons bar.

If the arrow is highlighted, it enables drag and drop mode. In drag and drop mode,
clicking in the timeline does not reposition the insertion point. Double-clicking in the
timeline selects the entire edit the mouse pointer is over. Dragging in the timeline repo-
sitions the edit the mouse pointer is over. This is useful for reordering audio playlists,
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Pulldowns
Transport & Buttons Bar

Timebar
Media Title

Video Track

Audio Track

Figure 2.3: Insertion point is at 0:00:25:10 in Hr:Mn:Sec:Frames

sorting movie scenes, or moving effects around. To cut and paste in drag and drop mode
you need to set in/out points to define an affected region.

If the I-beam is highlighted it enables cut and paste mode. In cut and paste mode,
clicking in the timeline repositions the insertion point. Double-clicking in the timeline
selects the entire edit the cursor is over. Dragging in the timeline highlights a region.
The highlighted region becomes the region affected by cut and paste operations and
the playback range during the next playback operation. Shift-clicking in the timeline
extends the highlighted region.

When highlighting a region, the start and end points are either aligned to frames or
aligned to samples. When editing video, you will want to align to frames. When editing
audio you will want to align to samples. Select your preference by using settings→align
cursor on frames.

Figure 2.4: I-beam + in/out + labels
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2.1.6 In/Out Points

In both editing modes, you can set one In point and one Out point. The in/out
points define the affected region. In drag and drop mode, they are the only way to
define an affected region. In both cut and paste mode and drag and drop mode, the
highlighted area overrides the In/Out points. If a highlighted area and In/Out points
are set, the highlighted area is affected by editing operations and the In/Out points are
ignored. If no region is highlighted, the In/Out points are used. To avoid confusion, it
is better to use either highlighting or In/Out points but not both simultaneously.

To set in/out points, go to the timebar and position the insertion point somewhere.
Select the In point button. Move the insertion point to a position after the In point and
click the Out point button. Instead of using the button bar, you can use the [ or < and
] or > keys to toggle in/out points.

If you set the insertion point somewhere else while In/Out points already exist,
when you click the In/Out buttons the existing points will be repositioned. If you click
on in/out points while a region is highlighted, the insertion point will be ignored and
In/Out points will be set at the beginning and at the end of the highlighted area.

If you select either the In point or the Out point, the insertion point will jump to
that location. After selecting an In point, if you click the In point button the In point
will be deleted. After selecting an Out point, if you click the Out point button the Out
point will be deleted. Shift-clicking on an In/Out point highlights the region between
the insertion point and that In/Out point. If a region is already highlighted, it extends
the highlighted region up to that In/Out point.

To quickly get rid of In/Out points, without caring about where they are or if they
are set or not, just double click on [ and ] buttons. The first click will set a new point
or reposition an old one at the insertion point; the second click will delete it. This trick
does not work if the In point or the Out point is already set at insertion point.

Some of the useful operations concerning the In/Out pointers are listed next.

Ctrl-KeyPad# if in/out set, KP 2,3,5,6 + Enter, play between In/Out point

Shift-Ctrl loops play between In/Out points

Click in/out while holding the left mouse button, drags In/Out pointer elsewhere

Shift-Ctrl with transport button, loops play between In/Out points

Ctrl-t clears both In/Out points
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2.1.7 Labels

The insertion point and the In/Out points allow you to define an affected region,
but they do not let you jump to exact points on the timeline very easily. Labels are an
easy way to set exact locations on the timeline that you want to jump to. When you
position the insertion point somewhere and click the label button, a new label appears
on the timeline. With label traversal you can quickly seek back and forth on the timeline.

No matter what the zoom settings are, clicking on the label highlights it and posi-
tions the insertion point exactly where you set the label. The lower case letter “L” is a
shortcut for the label button.

Labels can reposition the insertion point when they are selected but they can also
be traversed with the label traversal buttons. When a label is out of view, the label
traversal buttons reposition the timeline so the label is visible. Keyboard shortcuts for
label traversal are:

Ctrl-left repositions the insertion point on the previous label.

Ctrl-right repositions the insertion point on the next label.

The Label folder in the Resources window lists the timestamp of every label. You
can edit the label list and add a title for every item using the popup menu. To open the
Label info dialog right click on the label icon in the Resources window or directly on the
label symbol on the timebar. With labels you can also select regions:

Shift-Ctrl-left highlights the region between the insertion point and the previous label.

Shift-Ctrl-right highlights the region between the insertion point and the next label.

Double-clicking on the timebar between two labels highlights the region between the
labels.

Shift-clicking on a label highlights the region between that label and the insertion
point. If a region is already highlighted, it extends the highlighted region up to
that label.

If you hit the label button when a region is highlighted, labels are created at each
end of the highlighted region. However, if one end already has a label, then the existing
label is deleted. Hitting the label button again when a label is selected deletes it. Man-
ually hitting the label button or L key over and over again to delete a series of labels can
get tedious. To delete a set of labels, first highlight a region, then use the Edit→Clear
labels function. If in/out points exist, the labels between the in/out points are cleared
and the highlighted region is ignored.
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In Cut and Paste editing mode only, by enabling Edit labels in the settings menu or
by disabling the Lock labels from moving button on the program toolbar, labels will be
cut, copied or pasted along with the selected region of the first armed track. Similarly,
if a selected area of a resource is spliced from the viewer to the timeline in a position
before labels, these labels will be pushed to the right on the timebar for the length of
the selected area. To prevent labels from moving on the timebar, just disable the Edit
labels option or enable the Lock labels from moving button.

Originally in Drag and Drop editing mode labels will be always locked to the time-
bar, even with the Edit labels option enabled. This may no longer be correct in all cases.

2.1.8 Color Title Bars and Assets

In order to visually aid in locating clips on the timeline that are from the same
media file, you can have them auto-colored or self-colored. Use of this feature requires
additional memory and cpu on every timeline redraw, therefore it is recommended that
smaller computers leave it turned off.

For auto-color the color will be based on a hashed filename so that whenever you
load this particular media, it will always have the same color on the title bar even if you
use proxy. To enable auto-color (figure 2.5, go to Settings→Preferences, Appearance
tab and check on “Autocolor assets”. It is disabled by default. Each media will have
a random muted color and there could easily be close duplicates as generated by the
program algorithm. There will be no total black, but some dark shades are possible.

Screencast shows the red colored checkmark to enable Autocolor assets. In the
lower left corner is Highlighting Inversion color which can also be set and is discussed
elsewhere.

To change a specific clip to your own chosen color, middle mouse button over that
clip and an Edits popup will be displayed. Choose the option Bar Color to bring up the
color picker and choose a color. You can also change the alpha value in the color picker
and this alpha takes precedence over the current alpha slider bar value unless it was
set to 1.0. The color will only change after you click on the checkmark. The Bar Color
option works in either Drag and Drop or Cut and Paste editing mode and also works if
“Autocolor assets” is not set. In Drag and Drop editing mode, if you select several clips
and then bring up the Edits popup with the middle mouse button over a track, you can
use the Bar Color option to change all of those selected to the same color.

To go back to the default colors, uncheck “Autocolor assets” in Preferences, but
this does not affect the specially chosen self-colored ones as they are preserved. To
change these individually or selectively use the Edits popup Bar Color option and click
on “Default” in the color picker window. Auto-color does not honor armed/disarmed
tracks. Self-color does honor armed/disarmed tracks.
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Figure 2.5: Autocolor assets

And that’s not all! There is an alpha fader slider bar on the bottom of the main
window on the right hand side of what is referred to as the Zoom Panel. With this alpha
slider, you can colorize your video and audio tracks to either see only the color at 0.0
or see only the image/audio waveform at 1.0. This slider bar affects all colored areas of
the Autocolor assets and the self-colored ones. In the case when a specifically changed
edit alpha value is any value except 1, the slider bar will not affect that. Once you use
the slider bar, it is activated so gets first shot at any keystrokes in the main window. You
deactivate this by simply clicking in a different part of the main window.

As long as we are on the subject of color, just a reminder that you can also change
the “Highlighting Inversion color” in Settings→Preferences, Appearance tab. This is on
right left hand side of the menu more than half the way down and you can see this in
the figure 2.5. That setting defaults to white (ffffff) but sometimes this is a little bright
so you can put any hex value in that suits you.

Screencast (figure 2.6a) which shows an example of the Autocolor assets with alpha
set to 0.0. In this screencast (figure 2.6b), the alpha is set to show the image as well as
the colors. The pink media file has been self-colored rather than the autocolor to make
it easy to see.
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a) b)

Figure 2.6: An example of the Autocolor assets

2.1.9 More about Pulldowns

The main window pulldowns are quite obvious in their meaning and usage, so here
is only a summary.

File options for loading, saving, and rendering as described in other sections.

Edit edit functions; most of which have shortcuts that you will quickly learn.

Keyframes keyframe options which are described in the Keyframe section.

Audio audio related functions such as “Add track”, “Attach transition/effect”.

Video video functions such as “Default/Attach transition”.

Tracks move or delete tracks are the most often used.

Settings this is mostly described in other sections. However, typeless keyframes are
not described anywhere else. They allow keyframes from any track to be pasted
on either audio or video tracks.

View for display or modifying asset parameters and values to include Fade, Speed, and
Cameras.

Window window manipulation functions.

2.1.10 Window Layouts

If you like to use different window layouts than the default for certain scenarios,
you can setup, save, and load 4 options. First position your Cinelerra windows where
you want them to be and then use the Window pulldown and choose Save layout. To use
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the default name of Layout #, when the popup comes up, just click the green checkmark
OK on the Layout popup menu. If you would like a specific name for your layout so you
can remember what it is for, keyin 1-8 english characters that are meaningful to you
(english characters mean you can not use the German umlaut or the French accent).
Legal characters are a-z, A-z, 0-9, _ (the underscore character) and a limit of 8 total. If
you keyin more than 8, only the last 8 characters will be used. To rename a currently
existing layout, use the Save layout option again on the one to rename, and keyin a
different name into the text box or blank for the default name (figure 2.7).

a) b)

Figure 2.7: Window Layouts

The files containing the coordinates for your layouts will automatically be saved in
the $HOME/.bcast directory as layout#_rc or layout#_8chars_rc.

To use the desired layout, keyin the shortcut or use the Window pulldown and
choose Load layout and then make your choice.

2.1.11 Just Playing!

What if you are just using Cinelerra to play media and listen to tunes? After loading
your media, just hit the space bar to start playing and then again to stop playing. Other
than that, use the transport buttons on the top bar of the Program window. Other ways,
not previously mentioned to “play around” are described next.
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Repeat Play / Looping Method

There are 2 methods for repeat play or looping on the timeline and 1 method for
both the Compositor and the Viewer. This works in conjunction with any of the transport
buttons or shortcuts in either forward or reverse as usual. The 1 exception is that the
Shift button can not be used to either add or subtract audio within the repeat area.

Shift-L on the Timeline, repeats the selection per the algorithm outlined next. When
setup, long green lines are displayed across the entire set of tracks which shows the start
and end of the loop.

1. Highlighted selection repeats loop and takes precedence over all other possibili-
ties. If the cursor is before the highlighted area, it will play up to the area and
then repeat the highlighted section. If the cursor is after the highlighted section,
play will start at the beginning until you get to the highlighted section and then
repeat.

2. When both In and Out pointers are set, it repeats the section between [ and ].

3. If only one of the In or Out pointers is set, it loops the whole media.

Ctrl+Shift+transport button on the Timeline, Viewer, and Compositor

1. Repeats entire media if no In or Out pointer set.

2. In and Out pointer set, repeats area between pointers.

3. Only In pointer set, repeats from In to end of media.

Last Play Position Memory

When you play media, the start/end playback positions are saved as if they had
been made into temporary labels. They appear on the timeline as purple/yellow hair-
line markers representing the last start/end labels for the last playback. They can be
addressed as if they are label markers using:

Ctrl← tab to the label before the cursor, that is “play start”

Ctrl→ tab to the label after the cursor, that is “play stop”

You can use these markers for re-selection. Additionally, the selection region can
be expanded by “pushing” the markers using single frame playback. Use frame reverse
(keypad 4) to push the start play marker backward, or use frame forward (keypad 1)
to push the end play marker forward.
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Another handy feature is to use the combination of Ctrl-shift-arrow (left or right)
to select the media from the cursor position (red hairline) to the start or end marker by
“tabbing” to the label markers. For example, tab to the beginning of the previous play
region using Ctrl-left-arrow to move the cursor to the beginning of last play, then press
Ctrl-Shift-right-arrow to tab to the end of the playback region. Now you can clip/play/-
expand or edit the previous playback selection.

Ctrl SHIFT→ tab cursor to label right of cursor position and expand selection

Ctrl SHIFT← tab cursor to label left of cursor position and expand selection

Playback Speed Automation Support

The speed automation causes the playback sampling rate to increase or decrease to
a period controlled by the speed automation curve. This can make playback speed-up
or slow-down according to the scaled sampling rate, as “time is multiplied by speed”
(speed X unit_rate).

Alternative to using Numeric Keypad for Playing

For the keyboards without a numeric keypad or if you prefer to use keys closer to
where you normally type, there are alternative keys for the play/transport functions.
These are listed below.

Alt + m = stop playback
Alt + j = forward single frame
Alt + k = forward slow playback
Alt + l = forward normal playback
Alt + ; = forward fast playback
Alt + u = reverse single frame
Alt + i = reverse slow playback
Alt + o = reverse normal playback
Alt + p = reverse fast playback

+ Shift key, results in the reverse of
whether audio is included or not.

+ Ctrl, results in the transport func-
tion operating only between the in/out
pointers.

2.2 Compositor Window

The Compositor window (figure 2.8) displays the output of the timeline. It is the
interface for most compositing operations or operations that affect the appearance of
the timeline output. Operations done in the Compositor affect the timeline but do not
affect clips.
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Figure 2.8: Upper right side contains navigation tools / bottom bar has manu control
functions

2.2.1 Compositor controls

Navigating the video output does not affect the rendered output; it just changes
the point of view in the compositor window. The video output has several navigation
functions. The video output size is either locked to the window size or unlocked with
scrollbars for navigation. The video output can be zoomed in and out and panned. If it
is unlocked from the window size, middle clicking and dragging anywhere in the video
pans the point of view. Hitting the + and - keys zooms in and out of the video output.

Underneath the video output are copies of many of the functions available in the
main window. In addition there is a zoom menu and a tally light. The zoom menu
jumps to all the possible zoom settings and, through the Auto option, locks the video to
the window size. The zoom menu does not affect the window size. The tally light turns
red when rendering is happening. This is useful for knowing if the output is current.
Right clicking anywhere in the video output brings up a menu with all the zoom levels,
zoom auto mode, and some other options. In this particular case the zoom levels resize
the entire window and not just the video. The Reset camera and Reset projector options
center the camera and projector. The Hide controls option hides everything except the

28



2.2. Compositor Window

video.
On the left of the video output is a toolbar specific to the compositor window. The

toolbar has the following functions:
Protect video— disables changes to the compositor output from clicks in it. It is an

extra layer on top of the track arming toggle to prevent unwanted changes.
Magnifying glass — this tool zooms in and out of the compositor output without

resizing the window. If the video output is currently locked to the size of the window,
clicking in it with the magnifying glass unlocks it and creates scrollbars for navigation.

Left clicking in the video zooms in;

Ctrl clicking in the video zooms out;

Rotating the wheel on a wheel mouse zooms in and out.

In addition, if you enable the Magnifying glass, a zoom slider for fine-viewing
appears below these tools. It allows you to zoom to most any size. A “zoom slider” will
pop-up towards the bottom on the left-hand side of the Compositor when you enable
“Zoom view” via the magnifying glass or when you click on the icons for “Adjust camera
automation” or “Adjust projector automation”. This will allow for adjusting the amount
of zoom at any level between 0.01 and 100 based on a logarithmic scale. When using
the zoom slider, the number by which the view is zoomed can be seen in the textbox
where the original-also-working % zoom is located. The zoom slider size is in the form
of “times”, such as x 0.82 which indicates that the picture is zoomed to 82/100th of the
original size as seen in Settings→Format. Once you have set the zoom to the desired
size, use the vertical and horizontal scroll bars to position the view as needed.

Screencast (figure 2.9) shows below at a zoom slider bar with the diamond shaped
slider in the middle. Note that the magnifying glass is enabled which automatically
pops-up the slider.

The Format shows a large 5204x3468 video and the box at the arrow shows x 0.82
size.

Masks tool this tool brings up the mask editing tool. Enable “Show tool info” to see
the options.

Camera the camera brings up the camera editing tool. Enable “Show tool info” to see
options.

Projector the projector brings up the projector editing tool. Enable “Show tool info”
for options.
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Figure 2.9: A zoom slider bar with the diamond shaped slider in the middle

Crop tool this tool brings up the cropping tool. “Show tool info” must be enabled to
use this tool.

Eyedropper brings up the eyedropper. The eyedropper detects whatever color is under
it and stores it in a temporary area. Enabling the “Show tool info” shows the
currently selected color. Click anywhere in the video output to select the color
at that point. The eyedropper not only lets you see areas which are clipped, but
its value can be applied to many effects. Different effects handle the eyedropper
differently.

Show tool info this tool button works only in conjunction with the other controls on
the compositor. Based on what compositing control is active, the toggle button
will activate or deactivate the appropriate control dialog box. Controls with dialog
boxes are: Edit mask, Camera and Projector automation, Crop control, and Get
color.

Safe regions tool draws the safe regions in the video output. This does not affect the
rendered output
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2.2.2 Compositing

A large amount of Cinelerra’s editing is directed towards compositing. Changing
the resolution of a show, making a split screen, and fading in and out among other things
are all compositing operations in Cinelerra. Cinelerra detects when it is in a compositing
operation and plays back through the compositing engine only then. Otherwise, it uses
the fastest decoder available in the hardware.

Compositing operations are done on the timeline and in the Compositor window.
Shortcuts exist in the Resource window for changing some compositing attributes. Once
some video files are on the timeline, the compositor window is a good place to try
compositing.

2.2.3 Camera and Projector

In the compositor window, two of the more important functions are the adjust
camera automation and the adjust projector automation which control operation of the
camera and projector. Cinelerra’s compositing routines use a "temporary", a frame of
video in memory where all graphics processing is performed. Inside Cinelerra’s com-
positing pipeline, the camera determines where in the source video the "temporary" is
copied from. The projector determines where in the output the "temporary" is copied
to. Each track has a different "temporary" which is defined by the track size. By resizing
the tracks you can create split screens, pans, and zooms.

In compositing, each frame can be digitally altered using various options, such
as a color correction plugin (figure 2.10). Once the image has been transformed, the
finished image is then projected to the compositor thus creating a modified version of
the original.

When editing the camera and projector in the compositing window, the first track
with record enabled is the track affected. Even if the track is completely transparent,
it is still the affected track. If multiple video tracks exist, the easiest way to select one
track for editing is to Shift-click on the record icon of the track. This solos the track.

The purpose of the projector is to place the contents of the "temporary" into the
project’s output. The intent of the projector is to composite several sources from the
various tracks into one final output track. The projector alignment frame is identical
to the camera’s viewport, except that it guides where on the output canvas to put the
contents of each temporary.

Compositing projector controls

When the projector button is enabled in the compositor window, you are in pro-
jector editing mode. A guide box appears in the video window. Dragging anywhere in
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Figure 2.10: Camera and Projector

the video window causes the guide box to move along with the video. Shift-dragging
anywhere in the video window causes the guide box to shrink and grow along with the
video. Once you have positioned the video with the projector, you may want to work
with adjusting the camera automation.

Compositing camera controls

Select the camera button to enable camera editing mode. In this mode, the guide
box shows where the camera position is in relation to past and future camera positions
but not where it is in relation to the source video. Dragging the camera box in the
compositor window does not move the box but instead moves the location of the video
inside the box. The viewport is a window on the camera that frames the area of source
video to be scanned. The viewport is represented as a red frame with diagonal cross
bars.

Viewport sizes

The size of the viewport is defined by the size of the current track. A smaller
viewport (640x400) captures a smaller area. A larger viewport (800x200) captures an
area larger than the source video and fills the empty spaces with blanks. Once we have
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our viewport defined, we still need to place the camera right above the area of source
video we are interested on. To control the location of the camera:

1. Open the compositor window with a track selected.

2. Select the camera button to enable camera editing mode.

3. Drag over the display window.

When we drag over the viewport in the compositor window, the way it looks is as
if you “move the camera with the mouse”. The viewport also moves with it.

In the compositing window, there is a popup menu of options for the camera and
projector. Right click over the video portion of the compositing window to bring up the
menu.

Reset Camera causes the camera to return to the center position.

Reset Projector causes the projector to return to the center.

The camera and projector tool window

The camera and projector have shortcut operations that do not appear in the popup
menu and are not represented in video overlays. These are accessed in the Show tool
info window. Most operations in the Compositor window have a tool window which is
enabled by activating the question mark icon.

Figure 2.11: Camera and
Projector tool

In the case of the camera and projector, the tool win-
dow shows x, y, and z coordinates. By either tumbling or
entering text directly, the camera and projector can be pre-
cisely positioned. Justification types are also defined for
easy access. A popular justification operation is upper left
projection after image reduction. This is used when reduc-
ing the size of video with aspect ratio adjustment. In the last
figure you see the choices for justification as the red stripe
in the 6 boxes in the order of left, center horizontal, right,
top, center vertical, and bottom.

The translation effect allows simultaneous aspect ratio
conversion and reduction but is easier to use if the reduced
video is put in the upper left of the “temporary” instead of in the center. The track size
is set to the original size of the video and the camera is centered. The output size is
set to the reduced size of the video. Without any effects, this produces just the cropped
center portion of the video in the output.
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The translation effect is dropped onto the video track. The input dimensions of
the translation effect are set to the original size and the output dimensions are set to
the reduced size. To put the reduced video in the center subsection that the projector
shows would require offsetting out x and out y by a complicated calculation. Instead,
we leave out x and out y at 0 and use the projector’s tool window. By selecting left
justify and top justify, the projector displays the reduced image from the top left corner
of the “temporary” in the center of the output.

2.2.4 Masks

Masks select a region of the video for either displaying or hiding. Masks are also
used in conjunction with another effect to isolate the effect to a certain region of the
frame. A copy of one video track may be delayed slightly and unmasked in locations
where the one copy has interference but the other copy does not. Color correction may
be needed in one subsection of a frame but not another. A mask can be applied to just
a subsection of the color corrected track while the plain track shows through. Removal
of boom microphones and airplanes are a common kind of mask uses.

The order of the compositing pipeline affects what can be done with masks. Mainly,
masks are performed on the temporary after effects and before the projector. This means
multiple tracks can be bounced to a masked track and projected with the same mask.

The compositing pipeline graph has a masking stage. There are 8 possible masks
per track. Each mask is defined separately, although they each perform the same oper-
ation, whether it is addition or subtraction.

Compositing pipeline with masks

1. To define a mask, go into the Compositor window and enable the mask toggle.

2. Next go over the video and click-drag. Note: You have to select automatic keyframes
if you wish to move a mask over time. If you do not, the mask position will be the
same even if you edit at different places on the timeline.

3. Click-drag again in another part of the image to create each new point of the
mask. While it is not the conventional Bezier curve behavior, this masking inter-
face performs in realtime what the effect of the mask is going to be. Creating each
point of the mask expands a rubber band curve.

Once points are defined, they can be moved by Ctrl-dragging in the vicinity of
the corner. Shift-drag allows you to move existing points to new locations, thus
altering the shape of the mask. However, this does not smooth out the curve. The
In/Out points of the Bezier curve are accessed by Ctrl-dragging in the vicinity of
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the corner. Then Ctrl-dragging near the In or Out point causes the point to move.
Shift-drag activates bezier handles to create curves between mask points.

4. Finally once you have a mask, the mask can be translated in one piece by Alt-
dragging the mask. The effect of the mask is always on. Ctrl-Alt-drag translates
an entire mask to a new location on the screen.

The masks have many more parameters which could not be represented with video
overlays. These are represented in the tool window for masks. Selecting the question
mark when the mask toggle is highlighted brings up the mask options window (fig-
ure 2.12).

Figure 2.12: Mask options window

The mode of the mask determines if the mask removes data or makes data visible.
If the mode is Subtract alpha, the mask causes video to disappear. If the mode isMultiply
alpha, the mask causes video to appear and everything outside the mask to disappear.

The Value of the mask, set by a slider bar, determines how extreme the subtraction or
addition is. In the subtractive mode, higher values subtract more alpha. In the additive
mode, higher values make the region in the mask brighter while the region outside the
mask is always hidden.

The Mask number determines which one of the 8 possible masks we are editing.
Each track has 8 possible masks. When you click-drag in the compositor window, you
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are only editing one of the masks. Change the value of mask number to cause another
mask to be edited. The previous mask is still active but only the curve overlay for the
currently selected mask is visible. Whenmultiple masks are used, their effects are OR-ed
together. Every mask in a single track uses the same value and mode.

The edges of a mask are hard by default but this rarely is desired. The Feather
parameter determines how many pixels to feather the mask. This creates softer edges
but takes longer to render.

Two checkbox options are Apply mask before plugins and Disable OpenGL masking.
Note that the OpenGL mask renderer is of low quality and only suitable as a preview
for initial work. For fine-tuning of masks (with large feather values) OpenGL masking
should be switched off so that the software renderer is used instead.

Finally, there are parameters which affect one point on the current mask instead of
the whole mask. These are Delete, X, and Y. The active point is defined as the last point
dragged in the compositor window. Any point can be activated merely by Ctrl-clicking
near it without moving the pointer. Once a point is activated, Delete deletes it and X, Y
allow repositioning by numeric entry.

2.2.5 Cropping

Cropping reduces the visible picture area of the whole project. It changes the values
of the output dimensions (width and height in pixels) and the X, Y values of the projector
in a single operation. Since it changes project settings it affects all the tracks for their
entire duration and it is not keyframable.

Figure 2.13: Cropped area is in the top right corner
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• Enable the crop toggle and the tool window in the compositor window to display
the Crop control dialog box.

• Click-drag anywhere in the video to define the crop area. This draws a rectangle
over the video.

• Click-drag anywhere in the video to start a new rectangle.

• Click-drag over any corner of the rectangle to reposition the corner.

• Alt-click in the cropping rectangle to translate the rectangle to any position with-
out resizing it.

• The crop control dialog allows text entry of the top left coordinates (X1,Y1) and
bottom right coordinates (X2,Y2) that define the crop rectangle. When the rect-
angle is positioned, hit the Do it button in the crop control dialog to execute the
cropping operation: the portion of the image outside the rectangle will be cut off
and the projector will make the output fit the canvas.

• The Set Format window will show the new project Width and Height values.

• The projector tool window will show the new X, Y values.

• Track size will remain unchanged.

To undo the cropping enter the original project dimensions in the Set Format win-
dow and click on Reset projector in the popup menu of the compositor.

2.2.6 Safe Regions

On consumer displays the borders of the image are cut off and within the cut-
off point is a region which is not always square like it is in the compositor window.
The borders are intended for scratch room and vertical blanking data. You can show
where these borders are by enabling the safe regions toggle. Keep titles inside the inner
rectangle and keep action inside the outer rectangle.

2.2.7 Track and Output Sizes

The size of the temporary and the size of the output in our compositing pipeline
are independent and variable. The camera’s viewport is the temporary size. Effects are
processed in the temporary and are affected by the temporary size. Projectors are ren-
dered to the output and are affected by the output size. If the temporary is smaller than
the output, the temporary is bordered by blank regions in the output. If the temporary
is bigger than the output, the temporary is cropped.
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Figure 2.14: Note the black frames showing the safe regions

Track size

The temporary size is defined as the track size. Each track has a different size. Right
click on a track to bring up the track’s menu. Select Resize Track to resize the track to
any arbitrary size. Alternatively you can select Match output size to make the track the
same size as the output. If you resize a track, then its appearance on the compositor
changes accordingly. Using the relationship between the track and the project’s output
size you can effectively reduce or magnify the size of a particular track with regards to
the final output and therefore create visual effects like split screens, pans, and zooms
on the compositor.

Output size

The output size is set in either File→New when creating a new project or Settings
→ Format. In the Resources window there is another way to change the output size.
Right click on a video asset and select Match project size to conform the output to the
asset. When new tracks are created, the track size always conforms to the output size
specified by these methods.
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When rendering, the project’s output size is the final video track size where the
temporary pipeline is rendered into. If the output size is larger than the temporary then
the image transferred from the temporary will fit inside the Output Track. Any space
left on the Output is left blank. If the output size is smaller than the temporary then
some of the temporary video will be cropped.

2.3 Viewer Window

The viewer window (figure 2.15) is a place to load and preview your source media
and clips. Here you can quickly browse through an asset using the slider control, focus
on an area of work with the preview region or you use editing controls to cut and paste
segments into the project or create a clip for later use.

Figure 2.15: Viewer Window

To open the viewer window, go to Window→Show Viewer. The display is the area
on the viewer where you actually see media playing. Before you can play any media,
you must first load it on the viewer. To load media into the viewer:

1. Open the resources manager window and select the Media folder or the Clip
folder.

2. Drag a file from the Media or the Clip folder to the viewer.

You can also load media onto the viewer by right clicking on a file in the asset
manager and selecting View from the popup menu or by double clicking on the icon.
Once your media loads you will see it appear on the display. To play, rewind or forward
through it use the slider control or the transport controls. You can change the media
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display size by right clicking on the screen to activate the display zoom menu. Select
zoom levels of 50%, 100% or 200% of the original media size.

When displaying media, the viewer uses the project’s defined output size format
settings, not the original assets format. You can change the project’s output to match
the asset’s format using the match project size menu option in the asset manager. In the
Viewer you can move around in the source media or clips and select regions to paste
into the project. Operations done in the viewer affect a temporary EDL or a clip, but not
the timeline.

2.4 Options in both the Compositor and Viewer
Windows

The next sections describe capabilities that are available in both the Compositor
and Viewer windows.

2.4.1 Click to Play in Viewer and Compositor

In both the Viewer and Compositor windows, there is an arrow on the right hand
side of the other buttons in the edit panel. Mouse action can be toggled on/off via this
arrow, which has a tooltip of “Click to play” with the letter ‘p’ to be used for a shortcut.
When enabled there is a gold-colored shadow around the usual green-colored arrow.
The purpose of enabling this capability is to make it really easy to play the media in the
window by just using the left mouse button to start or stop the play. The entire main
canvas surface becomes a big play button! Although the default is initially off, a good
reason to enable this, at least temporarily, is so that you can quickly review your video
before a render.

left click forward play or stop forward play if already playing

middle wheel single frame forward or back

middle click reverse play or stop reverse play if already playing. Note that some 3
button mice do not accommodate a middle click for reverse but you can find out
by testing from a terminal window with the command xev.

2.4.2 Timebar + Preview Region Usage in the Compositor and
Viewer

The navigation features of the Viewer and Compositor behave very similarly. Each
has a timebar and slider below the video output. The timebar represents the entire time
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covered by the program. When you have a file loaded in the main window and then
slide around it using the compositor slider. The insertion point in the main window
follows the compositor.

Labels and in/out points are fully supported in the viewer and compositor. In the
viewer and compositor, labels and in/out points are displayed in the timebar. But there
is a difference between the viewer and compositor in that the compositor reflects the
state of the program while the viewer reflects the state of a clip but not the program.
When you hit the label button in the compositor, the label appears both in the compos-
itor timebar and the program timebar. When you select a label or in/out point in the
compositor, the insertion point in the program window jumps to that position.

The timebar in the compositor and the viewer can be used to define a region known
as the preview region. This preview region is the region of the timeline which the slider
affects. By using a preview region inside the entire program and using the slider inside
the preview region you can very precisely and relatively quickly seek in the compositor
and viewer. The preview region can be especially handy when you have large pieces of
media by previewing one section, then move to the next section.

The active preview region is the zone between the edge bars. The full range of the
window slider pointer action is down-scaled to the active preview region. To use this,
set the preview active region as a media time region of interest. Now addressing the
timebar with the mouse only operates as if the timebar is zoomed to the scale of the
active preview zone. This has the effect of magnifying the interesting media in terms of
the mouse pointer addressing, for fine-tuning.

Figure 2.16: The arrow above the green colored “play forward” transport button is on
the timebar.

To create and use a preview region, hold down the right mouse button inside the
timebar on either end of the timebar close to the edge until you see the resize pointer.
While continuously holding the right mouse button down, drag the arrow away from
the end towards the middle of the timebar until you have the desired area outlined. The
slider will be a light blue color while the selected preview region will remain the same
initial black color. There are either a left or right resize pointer and you can click and
drag in either direction to expand or shrink the region.

You can slide the preview zone left or right by holding the right mouse button over
the preview zone where you will see a fat double headed arrow. The selected area will
move left or right as you drag and still retains the same size.
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Figure 2.17: A left-facing arrow on the right side of the blue slider bar is used to drag
the bar.

Figure 2.18: Here you can see the right-facing arrow used to drag the other end of the
slider bar. The black area between is the actual preview area.

Figure 2.19: Note the double-headed fat arrow in the preview area used to move the
selection over.

Settings:

1. If no preview region is set, increasing the length of the media on the timeline by
inserting media or appending, has no effect on the non-selected preview region.
That is, you will not see the blue slider suddenly mysteriously appear.

2. If the preview region is set, when you replace the current project or file, the
preview region is automatically disabled.

3. If the preview region is set, when you append data or change the size of the
current project, the preview region may appear to either move, shrink, or grow
depending on the new length of the media on the timeline.

4. To disable the preview region, you will have to drag both the right and the left
blue slider bars completely to their corresponding end so that there is no longer
any visible blue slider.

A good method for taking advantage of the preview region is described here. On
the main track canvas, scroll to the beginning of the area of interest. When you do
that, you will see in the compositor the red indicator line of that location. Now in the
compositor window, right mouse drag from the left side of the edge of the timebar to
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create the blue slider bar line up to the red indicator. Back in the main track canvas,
move to the location of the area you want to end looking and again you will see the red
indicator line in the compositor. Use the right mouse drag from the right to stop at that
end point. Using this method is often easier than continuous usage of the single frame
move which can be tedious.

One last interesting item of note— sometimes youmay wish to see just a little more
that is outside the preview region and you can do so! You can actually move outside the
compositor or viewer window space and view more, at least until you hit the end of the
monitor space.

2.5 Resources Window

Effects, transitions, labels, clips, proxies, user bins, and media assets are accessed
here. Most of the resources are inserted into the project by dragging them out of the
resource window. Management of resource allocation is also performed here.

Figure 2.20: Folders are in the first column with contents of that folder on the right
hand side

The resources window is divided into two areas (figure 2.20. One area lists folders
and another area lists the folder contents. Going into the folder list and clicking on
a folder updates the contents area with the contents of that folder. The folders can be
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displayed as icons or text. There are several variations for displaying the contents; select
Display text, Display icons, Display icons packed, Display icons list as types of display for
the assets or plugins. Use the letter “v” to easily scroll through the choices and see which
you prefer. You can also get to these options from the menu by a right mouse click in
the window.

A Search option is available for any of the folders in the Resources window (and
when using “Attach effect” on the main track canvas for the Plugins). As you type in
characters a match is made with that substring. Names that do not match are filtered
out making it a lot easier to find the item you are looking for. The characters can be any
where within the phrase and it does not matter if upper or lower case.

Other options you will see if you right mouse click in the folder which brings up
the menu are described next.

Load files for convenience to load files same as from the main window so you do not
have to move the mouse so far in case you have multiple monitors.

Display text/icons as described previously for format variations preference.

Select options are All, Used, Unused, and None. This gives you the capability to have
a set of the contents highlighted for ease of use so you can see what is or is not
loaded, or unset the highlight.

Sort items to sort the contents of the folder alphabetically. Especially helpful if you
accidentally did a drag and changed your mind or dropped suddenly so that the
assets no longer look nicely aligned.

Copy/Paste file list use to easily copy a set of files or paste a set of files between Cin
and windows.

Snapshot/Grabshot described elsewhere in more detail.

Using the right mouse click to bring up a menu in the folder area, you can also
switch from Display text to Display icons, Sort items and create, delete and manipulate
user defined folders/bins. Select Folder to create a user Folder or modify an existing
folder.

If you right mouse click on a highlighted/selected resource, several options are
available depending on whether the resource is an effect or transition or a piece of
media. You can highlight several for some options so that it is applicable to all of them,
such as Info. Those listed immediately below are the available choices for media assets.

Info provided basic Asset information; details are described later in this section.
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Display text/icons same as mentioned previously.

Sort same as mentioned previously.

Rebuild index if you switch from/to using ffmpeg/native formedia loading, you should
rebuild indexes. Or if you get hangs onmedia or strange looking tracks, youmight
want to rebuild indexes.

View use this option to bring up the media in the Viewer window.

View in new window in order to not overwrite your current viewer window, you can
open any number of viewer windows to simultaneously view multiple media.

Open mixers when you record with multiple cameras setup, you can work with them
most easily using the mixer mode. This is described in detail

Paste

Match if you need to change your media parameters you can choose from the following:
Match frame rate, Match project size, Match all

Remove use to Remove the asset from the project or with caution, to Remove from disk
permanently.

In the case of Effects or Transitions, a right mouse click on a highlighted selection
leads to an Info button which gives a short 1 line description of what the effect/transition
can be used for. For Labels, choices are Edit, Label, and Go to. For Clips, Nest and UnNest
as described elsewhere are available.

2.5.1 Info Asset Details

The asset Info window also can be used to display detailed information about the
selected/highlighted media file — available for any loaded media of type mpeg or ffm-
peg. This is extremely helpful in determining what type of media it is, size, resolution,
format, and type/number of audio streams. It is especially useful for multiple program
streams. You can have the info window popped on several of your assets simultaneously.

Figure 2.21 shows the “Detail” box to click on the left side and a simple, typical
output in the Asset Detail window on the right side. Also, note the highlighted media
in the Resources window.
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Figure 2.21: The “Detail” box

2.5.2 User Folders/Bins

Creating folders that are more specific to a particular project is helpful in better
organizing your work. This can be done by utilizing the files already loaded to the
“master” Media or Clips folders in the Resources window. Below are steps illustrating
an easy way to set up a folder.

1. In the Resources window (figure 2.22), in the location of the Video/Audio effects
and Media folders, bring up the “Folder...” popup by clicking the right mouse
button. Highlight, then click “New Media or Clips”.

2. In the “New folder” popup as shown below (figure 2.23), type in your folder name
in the textbox. Click OK.
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Figure 2.22: Highlight, then click “New Media
or Clips”. “Modify folder” can be used to change
the name of a folder. “Delete folder” in the
popup can be used to delete a folder.

Figure 2.23: Type in your
folder name in the textbox.
Click OK.

3. Select the “master” Media folder to see which files are currently loaded, fig-
ure 2.24. Highlight the files there that you want to copy to your new folder
(named Photos of Garden). Drag the files to the left and when you see the Photos
of Garden folder become highlighted, then drop there. You can drag and drop
any of the media from the “master” Media at any time. It flashes when the drop
is successful.

Figure 2.24: The “master” Media folder

Adding the Shift key before the ac-
tual drop, will allow for relative path
filenames instead of full path. But
you might want to include or eliminate
some of the media that exists in one of
the folders that you have set up already.
In this case you will want to click on the
“Modify folder” in the popup. When
you bring up the Modify folder window,
if you already have files in that folder,
you will see filters that were generated
automatically when you did a Drag and
Drop.
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Here is the filter
that was gen-
erated with the
original drop

When you click on the
Value portion of that
filter, the entire set of
files that are covered
by the filter rules pops
up. Now you can high-
light a target filename
that you would like to
remove, and just erase
that line and check the
green checkmark for
OK.

Figure 2.25: Modify target

To delete the entire set of files listed on the filter rule, highlight the rule line and
hit the “Del” button. To add a new filter rule, click on the “Add” button which will
automatically add a default line after any current lines. The default line will be a line
that matches everything in the “master” Media folder which is “Or Patterns Matches *”.
Click the right mouse button on the current field underneath the column header to see
the choices available for each column.

Modifications will not be in effect until you click on the green arrow OK button or
click on the Apply button. But once you hit Apply, clicking on the red X button will not
undo your changes. The filter/search rules are applied in the order listed in the Modify
folder window. You can change the order of the filter rules by highlighting the rule you
want to move and then drag and drop to a new location.

The figure 2.33 below displays the available choices for each field.
Information about the columns and rules for the search filters in the Modify folder

window follows.
Column headers:

Enable this column is used to designate the state of that filter rule
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Figure 2.26: The available choices for each field

Off disable the filter

And narrow your search; all of your search terms must be present

Or broaden your search to include more values

And Not exclude terms that do not contain the given value from your search
results

Or Not include terms that do not contain the given value from your search results

Target – this column designates which media asset attribute to look at

Patterns each line contains a filename filter, matches the file path

Filesize number of bytes in a file

Time date file was created

Track Type track type of video, audio, or audio video (for both)

Width Format width

Height Format height

Framerate Video framerate

Samplerate Audio samplerate

Channels Number of audio channels
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Duration Playback time in seconds — it uses the largest of audio or video if
contains both

Op – boolean operators used to narrow or broaden the relationship between your
search terms

Around about this value; use “+radius” for a search range: [target–radius ...
target+radius]

Eq equal to

Ge greater than or equal to

Gt greater than

Ne not equal

Le less than or equal

Lt less than

Matches exactly matches for strings

Value— the characteristic you are looking for with expressions that can be written
with the following:

Number (decimal points are allowed and will be converted to a standard form):

inf representing infinity

#[TtGgMmKk ] — where # represents a number and the characters mean:

inf = infinity
T = 1099511627776
t = 1000000000000
G = 1073741824
g = 1000000000
M = 1048576
m = 1000000
K = 1024
k = 1000

Scalar:
Number
Number+Number
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Date time:

date = year/month
date = year/month/day
time = hour:minute
time = hour:minute:second

date_time = date time

Duration:

day = #day | #days
week = #week | #weeks

month = #month | #months
year = #year | #years
delta = secs
delta = mins:secs
delta = hours:mins:secs

Around time: date time+duration

Around length: duration+duration

Table showing the allowed usage:

1 target: | eq ge gt ne le lt matches around
2 ++++++++++++++++++++++++++++++++++++++++++++++++++++++++
3 patterns | <---- strcmp ---------> + filter + nearest
4 file_size | <---- arithmetic -------+------> + radius
5 mod_time | <---- arithmetic -------+------> + radius
6 track_type | <---- member test ------+--------+------>
7 width | <---- arithmetic -------+------> + radius
8 height | <---- arithmetic -------+------> + radius
9 framerate | <---- arithmetic -------+------> + radius

10 samplerate | <---- arithmetic -------+------> + radius
11 channels | <---- arithmetic -------+------> + radius
12 duration | <---- arithmetic -------+------> + radius

where in the above, the filter can be:
filter = list
filter = token
list = [token]
list = [token]list

string = <chars>|<empty>
token = string
token = string*token
Examples with some caveats first:

1. “Or” generally includes or adds whereas “And” generally excludes or subtracts.
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2. The filters only work on media in the folder; if there is no media, then there is
nothing to search.

3. The examples below are not meant to be executed as a list of filters in Modify
folder, they are just single line examples to indicate what can work.

4. Sort is by filename base name (directory path not included automatically) except
when the “Around” operation is used and then it is sorted by that Target distance
first and then filename.

Table 2.1: Examples

Enable Target Op Value meaning

Or Patterns Matches *
all files from the Media
folder are included

And Not Filesize Lt 160000000
no files that are less
than 160MB in size

Or Not Time Ge 2018/07/30 06:13:00
files not greater than or
equal date

And Duration Eq 01:00
files included must
have 60 secs. Duration

Off Samplerate Ne 44000
off for now, but may
want to include later

And Framerate Around 24+1
files included all have
24 to 25 framerate

Or Patterns Matches [*.mp4]
all files with the exten-
sion of mp4

Or Time Around 2018/08/02 06:00:00 + 02:00:00 files at 4AM to 8 AM

2.5.3 Vicons & Aicons – aka Video Icons / Audio Icons

Vicons are video icons. Aicons are audio icons. By default the Resources window
will play the first 5 seconds of video or audio waveform looped in the area occupied by
the media icons (figure 2.27). This is enabled for the Media/Proxy folders in icon mode
when the mouse pointer is inside the Resources window.

The waveform in the figure 2.28 is displayed in the Resources window in the color
green/yellow for the 2 audio tracks. There is a colored bar on the top of each a-icon
where the color is based on the Color Spectrum — the smaller the time duration, the
redder the color; then as the time duration goes up, the color goes up so that you will
go to green, then yellow, then blue, then really dark blue, then purple for the audio files
1 hour and over. There are various other colors between these colors same as that seen
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Figure 2.27: Note "Full Play" mode and Vicons and Aicons in Media folder

in the color spectrum in the screenshot below. Colors are utilized from the hue wheel
in the counter-clockwise direction. Note that the horizontal line in the middle of the
a-icon is yellow/red representing the 2 audio tracks and is only red for mono.

Note that if in Settings→Preferences under the Appearance tab, you have unchecked
“Use thumbnails in resource window” you will only have default icons and none of the
above capabilities.

2.5.4 Resources Window Preview Mode

Preview mode can be used to pop up a window which draws the vicons/aicons
thumbnails in a larger size. Preview or “draw vicons” mode is a helpful feature of
cinelerra that lets you see and/or hear the first 5 seconds of the video for identification
purposes. The Preview mode/playback toggle is to the right of the Visibility label as
seen in the screenshot above. Preview mode is available for the Media, Proxy, Media
User Bins, and Clips but clips are only 1 image.

When “Preview”/“draw vicons” is enabled/active, if you click on one of the video
icons or an audio waveform icon, a view pops up that increases the size to 4 times
the surface area larger. This makes it easier to see or hear if it is the media you are
looking for in case you have many similar media files. To conserve memory, the video
is stored 8-bits per pixel which results in low image quality while the audio is 16-bit.
The reason for playing 5 seconds of a video for a vicon is that until the first I-frame,
the media frequently does not decode properly. In other words, a lot of media does not
begin at the “beginning” point and will not be properly rendered until enough data has
been read to assemble a picture. You can increase the thumbnail size, clarity of pixels
(memory size) and color mode but it takes a lot more memory. Change these values
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Color hue wheel. For illustration only

Figure 2.28: Draw Vicons | Screenshot display various audio file lengths; red is shortest.

in Settings→Preferences, Appearance tab, right hand side of the Layout section – be
aware that when you click OK, your session will re-initialize. You can also temporarily
increase the preview mini-window by use of the mouse wheel up or down.

There are 4 options for the preview mode.

1. Full Play is the default mode. This means all of the media will automatically play
when the mouse is in the Resources window and you can use the left mouse button
to click on specific media to see it pop up in a larger view. Audio only files do not
play the audio until the icon is clicked on and the waveform aicon pops up into
the 4x larger mode. Full Play includes the Mouse Over capabilities as described
below as well as the Inter-View Src Target functions.

2. No Play mode is especially useful on smaller computers and for users who find
the constant loop play to be somewhat distracting.

3. Mouse Over mode is activated by a single click on one of the vicons/aicons and
deactivated with another single click over any of the icons. Once activated, when-
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ever you just move the mouse over an icon, it automatically pops up the increased
size preview. The first time in your session that you enable this feature, it may
take a few seconds to load all of the icon previews into memory so be patient and
just wait. Mouse Over mode makes it quick and easy to preview without having
to drag the media to the viewer. You can still drag the media same as without
preview enabled.

4. Src Target mode gives easy access to the Inter-View source target available by
using the middle mouse button on media. There are 2 advantages to this mode
— there is no 5 second play loop taking up cpu time and the popup allows for
the use of the letter “f” on that popup to have it go to fullscreen mode. Src Target
mode in any scenario never plays sound as that is nonsensical usage. After the
initial click to pop media in this mode, you also have the Mouse over feature.

For any of the options, but not No Play, you can temporarily turn off that option
by clicking on the button using the middle mouse button. This helps to avoid having
the thumbnail get in the way of dragging or other functions. When you do, a line will
be drawn through the current preview mode so that you are aware that it is in No Play
mode until click it again.

Note that if in Settings→Preferences under the Appearance tab, you have unchecked
“Use thumbnails in resource window” you will only have default icons and no active pre-
views.

Figure 2.29: The location of the Preview/Draw Icons mode. Figure 2.30: Note the
line through the mode.

2.5.5 Moving clips/media from/to Resources window

If you have several media files loaded into the Resources window of one instance
of Cinelerra and want to load some of the same ones into another instance or just want
a listing to save in a file for later use, you can do this with these set of steps:
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Copy or paste a list of files in the Media Resources window:

1. create a highlighted selection of the desired media files in the media Resources
window

2. right click on an unused portion of that window to bring up the popup menu

3. select the “Copy file list” item and a file list box will appear that contains the full
path filenames

4. wipe the textbox using your standard copy/paste method to put the list of files in
the copy buffer

5. in another cinelerra instance, choose the “Paste file list” of the media Resources
window

6. paste the list of files, again using your standard paste method, into the new file
list box; press OK

7. the status bar of the main window will be updated as the file list is loaded to the
media folder (the purpose of displaying the status is simply to show that the load
is progressing normally).

Obviously this “Paste file list” feature means you can create a list of files outside
of cinelerra using an editor, wipe the names, and then use “Paste file list” to load them
into the media Resources window.

It is important to note that in the steps above, the Operating System cut and paste
capabilities are in use for steps 4 and 6 as opposed to Cinelerra’s c/v shortcuts. Since
the procedure varies among the distros, you will have to adapt to your specific one. For
example, a usage for ubuntu consists of:

4. Ctrl-c to copy the list of files; open gedit; Ctrl-v to paste the list of files into gedit

5. Ctrl-c or the standard way using the right click to copy this list from gedit

6. Ctrl-v paste the list of files into the new file list box, and press OK

In the Figure 2.31, one instance of cinelerra has 6 items in the Media area high-
lighted that were copied to the file list. Note how it includes the full pathname.

In this screenshot on another instance of cinelerra, there are only 2 items in the
media but the “Paste file list” box is ready to have the items inserted via the standard
text box paste method. When that is done, the additional 6 media files will be available
on this other instance too.

Another possible usage of this capability:
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Figure 2.31: Example of copy file list

1. Right Click on the Clips Resources window and use the “Paste Clip” option to paste
the Copy selection as a clip.

2. Similarly, by highlighting a clip in the Resources window and selecting its copy
popup menu item using the right mouse button, that copy buffer can now be
loaded onto the timeline.

2.5.6 Snapshot / Grabshot

Figure 2.32: Snapshot menu and choices
Figure 2.33: Grabshot reticle & orange box

To take a snapshot, perform the following steps:
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1. set your timeline insert marker where you want the snapshot — this frame shows
in the compositor

2. right click in an empty spot in the media folder and the popup shows snapshot as
the 5th item down

3. highlight that and the submenu comes up allowing you to choose png, jpg, ppm
or tiff

The snapshot shows up in the Media folder. It is saved by default in /tmp as
snap_date-time.ext BUT you can change the default directory path in Settings→
Preferences→Interface tab in the right hand side of the Editing section.

Grabshot is the 6th menu item. A red circle reticle can be moved to the area to
grab; use left mouse drag to surround an area; and right click to grab.

2.6 Other Options and Other Windows

2.6.1 Transport Controls

Transport controls are useful for navigation and for playing media. Each of the
Viewer, Compositor, and Program windows has its own transport panel. The controls
generally all contain a yellow colored tooltip when you mouse over the control, provid-
ing a hint of their function and shortcuts for usage.

The transport panel is controlled by the keyboard as well as the graphical interface.
For each of the operations it performs, the starting position is the position of the insertion
point in the Program window and the slider in the Compositor and Viewer windows.
The ending position is either the end or start of the timeline or the end or start of the
selected region if there is one.

The orientation of the end or start depends on the direction of playback. If it is for-
ward the end position is the end of the selected region. If it is backward the end position
is the start of the selected region. The insertion point moves to track playback. When
playback stops, the insertion point stays where playback stopped. Thus, by playing back
you change the position of the insertion point. The keyboard interface of either the nu-
meric pad or alternative keys has more speeds with the addition of Forward Slow(2) and
Reverse Slow (5). Hitting any key on the keyboard twice pauses it. The shortcuts section
of this manual as well as a Shell Command available from the Cinelerra main window
has a listing of each of the keys.

When using frame advance functions the behavior may seem odd. If you frame
advance forward and then frame advance backward, the displayed frame does not
change. This is because the playback position is not the frame but the time between
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two frames. The rendered frame is the area that the playback position crosses. When
you increment the time between two frames by one and decrement it by one, you cross
the same frame both times and so the same frame is displayed. There is an option
in Settings→Preferences, Appearance tab to “Always show next frame” that may help
make this clearer for some users.

The transport behavior changes if you hold down Ctrl when issuing any of the
transport commands. This causes the starting point to be the In point if playing forward
and the Out point if playing backward. If playing forward, the Out point becomes the
ending point and if playing backward, the In point becomes the ending point. If no
In/Out points are specified, the behavior falls back to using the insertion point and
track boundaries as the starting and ending points.

The transport behavior also changes if you hold down the Shift key along with
KeyPad 1–6. If normally audio is included in the play, it will be removed and if normally
audio is not included in the play, it will be added.

2.6.2 Zoombar

The compositor has zoom capability. The pull-down menu on the bottom of the
compositor window has a number of zoom options. When set to Auto the video is
zoomed to match the compositor window size as closely as possible. When set to any
other percentage, the video is zoomed a power of 2 and scrollbars can be used to scroll
around the output. When the video is zoomed bigger than the window size, you can
use scrollbars to scan around or if the zoom icon is enabled, the middle mouse button
can be used to zoom in or out the video.

The zoom toggle also causes the Compositor window to enter zoommode. In zoom
mode, clicking in the video output zooms in while a Ctrl-click in the video output zooms
out. If you have a wheel mouse, rotating the wheel zooms in or out too. Zooming in or
out with the zoom tool does not change the rendered output. It is merely for scrutinizing
video or fitting it in the desktop. Playing video on the compositor when zoomed to any
size other that 100%, the original size, requires Cinelerra to do extra processing steps.
This could affect performance on slower systems

2.6.3 Show Overlays

Color Coded Keyframe Curves are a big feature in the “Show Overlays” window
because by changing the colors to suit the user, it helps to remove confusion from
multiple curves on the track canvas. They can be viewed from the pulldown menu
of Window→Show overlays but they will operate the same as when used from the View
pulldown menu. The “Color Coded Keyframe Curves” have distinct colors associated
with each type for ease of identification. By clicking button 1 on the “Color Ball” to the
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right of any keyframe type in the “Show overlays” menu you have the ability to change
the colors to whatever works best for your video. The color ball changes made will be
retained across sessions.

There is a line separating the first 4 items, which are just non-automation type
settable values as opposed to “auto” keyframe types. The color is not changeable for the
3 items of Mode, Pan, and Mask which simply display their symbol icon.

Screenshot below displays the Show overlays popup with all of its options and
color coded types such as yellow for Speed and blue for Camera Z. Upon clicking on
the associated “color ball” to the right of any keyframe type, for example “Fade” in this
screenshot, the color wheel palette window pops up so that you can manipulate the
color as desired.

Figure 2.34: Show Overlays window on the left with the Color ball window to the right
to set color

Screenshot below shows several color coded lines for different keyframes along
with the Fade slider for manipulation. The slider is in the same color as the color coded
keyframe type line which is the same color as in the “Show overlays” window.

Overlays Window Nuances:
The Overlays window is an alternative to the main track canvas View pulldown,

and thus the order is mostly maintained to match each other. To make it easier to get
a quick temporary look at a specific option, there is a shortcut of Shift-LMB (left mouse
button) that can be used as opposed to having to uncheck everything that is currently
checked and then having to recheck them on when done. Here is a list of how they
work. Keep in mind that if the Expander on the patchbay is enabled, you still see the
track.

• Shift+LMB (left mouse button) in the Overlays Window on a checkbox will turn
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Figure 2.35: Lines are colored here on the timeline as designated in Show Overlays

off all other checkboxes except for the one you are on. Then this named box will
have outline for a "hot" spot.

• Shift+LMB on this "hot" spot will return to "cool" of the previous settings with all
of the previous checkboxes checked again.

• Shift+LMB on a non-"hot" spot will simply check or uncheck a box and there is
no previous state.

• This all works in conjunction with the View pulldown menu which, of course, has
no hot spots.

• Caveat #1 - Shift+LMB on the top 4 choices of Assets, Titles, Transitions, Plugin
Keyframes will turn off all of the checkboxes below because it makes sense to do
so.

• Caveat #2 - Shift+LMB on the Autos will not turn off Assets, Titles, Transitions,
or Plugin Keyframes because you need to be able to see what is going on.

• Caveat #3 - XYZ toggle on/off of Camera and Projector are not affected.
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Figure 2.36: Original
Settings — cool spot

Figure 2.37: Note Titles
box hot spot

Figure 2.38: Cam/Proj
XYZ toggle to fine tune

2.6.4 Sound Level Meters Window

An additional window, the levels window, can be brought up from the Window
pulldown. The levels window displays the output audio levels after all mixing is done.
The visible range of the sound level meters is configurable in Settings→Preferences,
Interface tab under the Operations section.

Sound level meters can be toggled in the viewer and compositor windows with the
show meters button. They also appear in the patchbay when the track is expanded and
in the recording monitor when audio is being recorded.

The sound levels in the levels window, compositor, and viewer correspond to the
final output levels before they are clipped to the sound card range. In the record monitor
they are the input values from the sound card. In the patchbay they are the sound levels
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2.6. Other Options and Other Windows

for each track after all effects are processed and before down-mixing for the output.
Most of the time, audio levels have numerical markings in dB but in the patchbay there
is not enough room.

Figure 2.39: Sound Level
Meters Window

The sound level is color coded as an extra means of
determining the sound level. Even without numerical mark-
ings, the sound level color can distinguish between several
ranges and overload. Look at the color codings in a me-
ter with numerical markings to see what colors correspond
to what sound level. Then for meters in the patchbay in
expanded audio tracks, use the color codings to see if it is
overloading.

Be aware that sound levels in Cinelerra can go above 0
dB. This allows for not only seeing if a track is overloading
but how much information is being lost by the overloading.
Overloading by less than 3 dB is usually acceptable. While
overloading is treated as positive numbers in Cinelerra, it is
clipped to 0 when sent to a sound card or file.
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